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IMPORTANT NOTICE — READ CAREFULLY

Use of this software and related materials is provided under the terms of the SoftPro Software License
Agreement. By accepting the License, you acknowledge that the materials and programs furnished are
the exclusive property of SoftPro. You do not become the owner of the program, but have the right to
use it only as outlined in the SoftPro Software License Agreement.

All SoftPro software products are designed to ASSIST in maintaining data and/or producing documents
and reports based upon information provided by the user and logic, rules, and principles that are
incorporated within the program(s). Accordingly, the documents and/or reports produced may or may
not be valid, adequate, or sufficient under various circumstances at the time of production. UNDER NO
CIRCUMSTANCES SHOULD ANY DOCUMENTS AND/OR REPORTS PRODUCED BE USED FOR ANY PURPOSE
UNTIL THEY HAVE BEEN REVIEWED FOR VALIDITY, ADEQUACY AND SUFFICIENCY, AND REVISED WHERE
APPROPRIATE, BY A COMPETENT PROFESSIONAL.
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SOFTPRO STANDARD V21 — RELEASE NOTES 9/13/2017

This release includes several notable changes:

The entire application interface has been updated with a new look and feel, including new icons,
launch screens, color, buttons, et cetera. The location and function of application screens and
fields will remain the same.
Documents and attachments have been enhanced in several notable ways. All v21 users will
receive this functionality for free with their ProForm license:

a. Files may now be attached by dragging & dropping them directly into an order.

Users may now print ReadyDocs directly to the order attachments.

b
c. Attachments can now be emailed with Outlook.
d. Any ReadyDoc can now be rendered and emailed as an attachment.

A number of bug fixes were made.

General

The appearance of SoftPro applications has been modernized and improved: 362650
-

@ ProForm Standard Edition - 2017090001,PFD =N EER ==

File Reports View DocumentMode Tools Services Support  Window Help

L0 =EF % ROL © oW B = 9=

. 2017090001.PFD (Main Folder) - [STD.21.0 - 09/05/2017] =n E=h <
General | Order Tracking | Title Insurance | CDF | NC Bar Forms|
Screens: ReadyDocs:

gﬁfﬁlﬁma‘%’c Algent UrE]defwritﬁr 4| User ReadyDocs Tree
ile Mo., Settlement Dates, Motes .5

3) Buyer/Bomower, Officers & Signatures | SoftFro ReadyDocs Tres
4) Seller, Officers & Signatures

5) Sales Price, Deposit/Eamest Money

6) Property, Legal Description

7) Lender

8) Mortgage Broker & Loan Servicer

9) Loan, Funding & ProTrust

10) Terms, Payment & ARM

11} Builder, Cortract & Escrow for Completion
12) Real Estate Agents/Brokers

13) Buyer's & Seller's Attomeys

14) HOA/Mgmt. Company

15) Addttional Cortacts

18) Acknowledgment & Motany

17) Affidavit/Agreement Regarding LiensWaiver
18) Security Instruments, Trustee & Riders

15) Conveyance

20) User Optional Fields 1-25

21} User Optional Fields 26-45

22) User Optional Fields 46-65

23) General Options

ToByr0.00 | FrmSIr0.00 | Balance:0.00 LKUP




SOFTPRO STANDARD V21 — RELEASE NOTES 9/13/2017

e To ensure best application display, use the following minimum font size/screen resolution
combinations: 206899
a. Smaller (default) font — 1024 x 768
b. Medium font — 1280 x 720
c. Large font - 1600 x 900
e To ensure that the new interface icons, colors, and layout are displaying at the highest quality,
users should verify that Windows Themes are turned ON.

ProForm

Attachments

ProForm Attachments no longer depends on an SPImage license. All v21 users will receive the
functionality associated with the Attachments dialog for free with their ProForm license. Additionally,
the SPImage license has been removed from the ProForm for Windows Licensing screen. SPImage users
will now find that license under the SoftPro for Windows Licensing screen within SPImage. 392259

Access

e The Tools > SPImage menu item has been renamed to Attachments:

ProForm Standard Edition - 2017090002.PFD
File Reports View Document Mode IIools Services  Support Window Help

GOE & E X % Spell Checking Preferences

ReadyDocs Manager...

WordPerfect Documents Manager...

M5 Word Documents Manager...

Check Printing Manager...

Prompts Manager...

LandAm Pelicy Mumbering Manager...
Greatland/5tate Documents Field Mapping Manager...
Title Insurance Premium Manager

CDF Delivery & Tracking...

Convert File to GFE...
Copy Lookups to GFE...

Attachments...

Drag & Drop
e Users may now drag and drop documents directly into the attachments window without using a
barcode coversheet. All common file types can be added in this way, including images, .pdfs,
Outlook emails/attachments, and more. 372552, 386555




SOFTPRO STANDARD V21 — RELEASE NOTES 9/13/2017
A Attachments (2017030001) (=]
Description Date/Time
Stewart 09/08/2017 10:33
PatriotSearchlUserGuide 03/08/2017 10:33
EncompasslserGuide  09/08/2017 10:33
Confirmati...
| vew. | | mtach.. | | Edt. | | Dekte.. || Emal. | [ ok |

e Users may also drag and drop files directly into the ProForm window. Once attached, they will

appear in the attachments window:

-

Cror ]
)4

FE

=

PatriotSearch
I ICPFFI I'HF' nH

Encom pas

[ POF |

Stewart.pdf
+

L File Reports

View Document Mode

Tools  Services

== |
BED

@ ProForm Standard Edition - 20017090001, PFD - [2017090001.PFD (Main Folder) - 210 - 094
Support indo

RE L ®© O W 5

o E

GEﬂE'E|| QOrder Tlad{ingl Title Insumncel CDF | MC Bar Furrns|

Screens:

1) Settlement Agent, Underwriter

2) File No., Settlement Dates, Notes

3) Buyer/Bomower, Officers & Signatures
4) Seller, Cfficers & Signatures

%) Sales Price, Deposit/Eamest Money
&) Property, Legal Description

7) Lender

8) Mortgage Brolcer & Loan Servicer

5) Loan, Funding & ProTrust

L Tems, Pament,

MM“WWMMH b T

[
ReadyDocs:

------ || User ReadyDocs Tree
2- ,_', SoftPro ReadyDocs Tree

| | Bar Code Cover
Order Tracking

,_', Title Insurance

|| Escrow & Closing

[ | Tnith-In-Lending HUD-1

it e P s




SOFTPRO STANDARD V21 - RELEASE NOTES 9/13/2017

Print to Attachments

e Users can now print ReadyDocs to the order attachments.
a. Access File > Print to Attachments:

pr

@ ProForm Standard Edition - 2017090001.PFD 5
File | Reports  View Document Mode Teools  Services SLIppE
Mew... Crl+M f

Express Order Entry... Ctrl+E
Open... Ctrl+C
Search... Alt+5

Overlay File/Template...

Close

Save Ctrl+5

Save As...

Export...
Export PFD File for Support...

Print... Ctrl+P
Print to POF...
Print to Attachments...

1

L T NP TP TV SRS, S

Ernail Documents...

|
|
|

b. Select all the documents you wish to render and save; they will all be saved into a single

.pdf file. Input a name into the file name field and click OK:

ReadyDocs Selection (Metwork)

Available ReadyDocs: Selected ReadyDocs:

o i User ReadyDocs Tree I P Bar Code Cover
E|__ SoftPro REEWDDCSV
| | Bar Code Cover
- Order Tracking Un
- Title Insurance .
| Escrow & Closing

-__| Truth-In-Lending HUD-1

-

Save to attachments as: | BarCode_ 2017090007

oK l [ Help ] [ Cancel

c. After clicking OK, you will receive a confirmation message letting you know that the
process is complete. The file will appear in the attachments screen.




SOFTPRO STANDARD V21 - RELEASE NOTES 9/13/2017

Email Attachments

e An Email functionality has now been added to the attachments and can be used when Outlook
is installed.
a. Open the order attachments. Select one or more attachments & click Email:

Attachments (2017090001} ==

Description Diate/Time

09/08/2017 10:33
Patriot Search UserGuide s WRTIREE]
s EEEEE e 09/08/2017 10:33

View.. | | Atach.. | [ Edt.

_

| o [ ]

b. The Email Addresses dialog will appear, displaying any email addresses that are included
in the order. Select the recipients you wish to include on the email and click OK:

I )

Email Addresses [5m]

Select the contacts to include in the email:

Cortact Type Cortact Name Cortact Email

Title Compary Samantha Kalloway Samartha. Kalloway ...
Mortgage Broker Donna Hue Donna. Hue @myspac...
Bunyer Paul Druthers Paul . Dnuithers@geocit...
[T Additonal Cortact Robert Xavier bob@titlecomp .com

I QK I4-E Cancel

i. If no email addresses exist in the order, no email addresses will populate on this
dialog. You may still click OK to attach the files to a new email and modify email
addresses manually; see the next step.

c. A new Outlook email will appear; files will be attached automatically. You may
customize the email prior to sending:




SOFTPRO STANDARD V21 — RELEASE NOTES 9/13/2017

BEBEH® G E"B = Real estate order 2017090001 documents - Message (HTML) T EH - O %
MESSAGE INSERT OPTIOMNS FORMAT TEXT REVIEW DEVELOFER

To.. Samantha. Kalloway @internet.org; | | Donna.Hue @myspace.com; | Paul.Druthers @geodties. com
Cc...
Send
Subject Real estate order 2017090001 documents
Attached "L stewart.pdf (3 MB); - PatriotSearchUserGuide.pdf 931 KB; - EncompassUserGuide.pdf & ME)
Hello all —

| attached the documents you requested. Please let me know if you are pleased to let me know you are pleased.

Best,

Lazlo Hollyfeld — Pacific Tech — 123.456.7850

T T P o Ay =

Email Documents

Users can render and send any ReadyDoc as an email attachment without having to go to the

Attachments screen. The email functionality can be used when Outlook is installed.

a.

Access File > Email Documents:

.

@ ProForm Standard Edition - 2017090001, PFD - [2007090001.PFD I[la‘lér

._-.[m Reports View Document Mode Tools Services SUE

Mew... Ctrl+M | é

G Express Order Entry... Ctrl+E _;;
S Open.. Ctrl+ O
Search... Alt+5

Overlay File/Template... \7

5 Close i?

g Save Ctrl+5 j

g Save As... i

3 3

-1| Export... £

:Il Export PFD File for Support... ':;

] Print... Ctrl+P }

:II Print to POF... f

1 Print to Attachments... {

1 Email Documents... — E

% Print Checks g

L e




SOFTPRO STANDARD V21 - RELEASE NOTES 9/13/2017

b. Select all the documents you wish to email; they will all be saved into a single .pdf file.
Input a name into the file name field and click OK.

ReadyDocs Selection (Metwork)

Available FeadyDocs: Selected ReadyDocs:
|| TLTA Documents - Closing Disclosure Form (Purchase), Pg 1
Escrow & Closing Closing Disclosure Form {(Furchase), Pg 2
_ CDF Documents || Closing Disclosure Form (Purchase), Pg 2a

| File Balance Shest
| Closing Disclosure Form (Purchase)

Closing Disclosure Form (Purchase), Pg Zb
Closing Disclosure Form (Furchase), Pg 3

| | Closing Disclosurs Form (Purchase), Pg 1 Closing Disclosure Form {Furchase), Pg 4

|| Closing Disclosurs Form (Purchase), Pg 2 Closing Disclosure Form {(Furchase), Pa 5

| | Closing Disclosure Form (Purchase), Pg 2a [ | | Closing Disclosure Form Addendum (Furchase)
|| Closing Disclosure Form (Purchase), Pg 2b
| | Closing Disclosure Form (Purchase), Pg 3
| | Closing Disclosurs Form (Furchase), Pg 4
| | Closing Disclosure Form (Purchase), Pg &
| | Closing Disclosure Form Addendum (Purch
| Closing Disclosure Form (Refinance) |4

m

l

t-.__| Closing Disclosure Form (Buyer)

+-{__| Closing Disclosure Form (Seller)

+-{__| Tax and Proration Summary -
| 1 »

-

-~

Attach to email as: CDF_Purchase_2017050001

oK l [ Help I [ Cancel

c. After the documents render as a .pdf, you will get an Email Addresses dialog. Select the
recipients you wish to include on the email and click OK:

o =

Email Addresses ==

Select the contacts to include in the email:

Contact Type Contact Name Contact Email

Title Comparmy Samantha Kalloway Samantha Kaloway ...
Martgage Broker Donna Hue Donna. Hue @myspac...
Buyer Paul Druthers Paul.Drnuthers@geocit...
[] Additonal Contact Fobert Xavier bob @titlecorp .com

OK | | Cancel

i. If no email addresses exist in the order, no email addresses will populate on this
dialog. You may still click OK to attach the document to a new email and modify
email addresses manually; see the next step.

d. A new Outlook email will appear; the .pdf will be attached automatically. You may
customize the email prior to sending:

10
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= H e - Untitled - Message (HTML) ? EH - 0O %
FILE MESSAGE  INSERT  OPTIONS  FORMATTEXT  REVIEW  DEVELOPER

To... Samantha.Kalloway@internet.org; | Donna.Hue@myspace.com; | | Paul.Druthers@oeodties. com
Cc..
S5end
Subject

Attached ™1 cDF purchase 2017090001.pdf 72 KB)

i e T T T T i T i T L T T e i et

ReadyDocs
e Words were running together in ReadyDocs after a Windows Creator Update (1073).

e A couple of zoom-related errors were occurring when previewing ReadyDocs; resolved.

Title Insurance

ALTA Endorsements
e Changes have been made to comply with the ALTA Endorsement 23.1-06 update effective on

August 1, 2017. This includes the following two documents:
a. Endorsement 23.1-06 (Co-Insurance Multiple Policies-Loan)
b. Endorsements 23.1-06 (Co-Insurance Multiple Policies-Owner’s)

Escrow & Closing
Tax Forms
e The Certification for 1099 Reporting Exemption (Legal And Letter) form was not pulling the SSN
for data entered in the SellerSSN2 {{slrlssn2}} position.

Tabs

CDF Page 2
e When Paid By Others was used in conjunction with the SIr% field in the Recording Fees details,

the Seller Paid At Closing amounts were being removed, resulting in incorrect totals.

11
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ProTrust
e Users may click into the Firm File ID field & use Ctrl+C to copy the ID for pasting elsewhere.
404879

File Edit Search Ledger Reports View Tools Help
m e (6 O0OW O PORO

Ledger Infarmation

== Firm File I0; 0000533224

Clignt,/t atter:

Ledger Cormment;

e The Add, Edit, & Delete Ledger Transaction icons have been repositioned directly above the
Transaction section. 97369

Eile Edit Search Ledger Reports Wiew Tools Help

m e JEd Ok & P78 O

Ledger Infarmation ir

Firm File 10 000053224

Clignt,/t atter:

Ledger Cormment;
Settlement Date: / / Reminder Date: / /
Buyer/Bormower: Bob Buyer
Seller: Lender: —l

Property: Loan #: i

Trust Account, TAC - R ezponzib

BB

Tranzaction Mumber  Date Cleared Armount Fayee Mame / Desc

Pending Check 15000 June Schwinn

12



